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Self Service – Reference 
 
The most frequently asked questions about the Self Service website (www.state.mn.us/employee)  
are answered here.  

Passwords 

Q. What if I remember my password but it doesn't work and the message “Your User ID and/or Password are 
invalid.” displays? 
A.  

• Try it again, making sure you type it in correctly. It is case-sensitive, so if your password contains letters and 
you established it in lower case, you must sign in using lower case letters. 

• Check your user ID to ensure it is correct. You must use your employee ID which is eight digits, all numeric. 
Be sure to include the leading zeros. 

• Ensure that NumLock is ON on your keyboard and CapsLock is OFF (unless you normally have CapsLock 
ON). 

• Have only one web browser window open with one tab when you sign into Self Service. 
• Sometimes, if you have tried 2 or 3 times, it is best to close the browser and then open it and try again. 
• Access Self Service directly by going to www.state.mn.us/employee , instead of using any desktop shortcuts, 

agency websites, or links from webpages. Sometimes the problem is with the interface to Self Service, rather 
than the Self Service website. 

• Clear cookies and temporary Internet files. Follow the instructions for clearing cookies and temporary 
Internet files. 

If your password still doesn't work, request a system-generated password.  Continue with step 1 below: 
1. Go to www.state.mn.us/employee.  
2. Click on the link that says, “Forgot Your Password?”  
3. You'll be prompted for your User ID. Enter it and click Continue.  
4. You'll be asked a question which you have previously specified, or you will be prompted for your Social 

Security Number. In the Response field, enter the answer (if entering your Social Security Number, do not 
include dashes). Click Create password.  

5. You'll be presented with a new, system-generated password. It is case-sensitive and consists of 10 
characters. 

6. Write it down exactly as it appears and click OK. (See below for timesaving hint.)  
7. The Self Service sign in page displays. (If the Self Service window closes, just go to 

www.state.mn.us/employee again and continue with these steps.) 
8. Enter your User ID (all eight digits, including any leading zeros).  
9. Enter the system-generated temporary password.  
10. Click Sign In. The Self Service menu page displays. 
11. Select State of MN Self Service to access the State of MN Self Service page. 

A timesaving hint: Copy and paste the new, system-generated password. In step 5, after you are presented 
with the new password, highlight it (only highlight the password’s 10 characters; do not highlight the space or 
characters following the 10th character), and with your cursor on the password, right-click and select Copy. 
Next, click OK. On the sign in page, after entering your user ID, right-click in the password field and select 
Paste.  (Confirm that only 10 bullets display. If there are more than 10 bullets, delete the extra bullets to the 
right.)  Click Sign In and the Self Service menu page displays.  

We recommend that you now change the system-generated password.  
(Note: If you don’t change your system-generated password, the password expiration date will not reset. This 
could result in receiving the “Your password has expired” message sooner than expected.) 

http://www.state.mn.us/employee
http://www.state.mn.us/employee
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To change your password, continue with these steps: 
1. On the State of MN Self Service page, select My profile.  The General Profile Information page displays.  
2. Click Change password. The Change password page displays.  
3. Enter the system-generated password in the Current Password field or, paste it if you didn't write it 

down. 
4. Tab to the New Password field and enter a password of your choosing. See Are there any requirements 

or guidelines for creating a password? 
5. Tab to the Confirm Password field and enter the new password again.  
6. Click OK. Unless you receive an error message, your password has been saved. 
7. The General Profile Information page displays.  

Q. What if my new system-generated temporary password doesn't work? 
A.  

• The system-generated temporary password will work, but you must type (or paste) it exactly as it is 
presented.  Note: After pasting, confirm that only 10 bullets display. If there are more than 10 bullets, delete 
the extra bullets to the right. 

• Clear cookies and temporary Internet files. Follow the instructions for clearing cookies and temporary 
Internet files. 

• Note: As a security precaution, you are temporarily locked out after too many failed sign-in attempts. These 
lockouts are cleared periodically. If you think you are locked out, try again the next day.  

Q. When trying to sign in, I receive the message “Your Account is Locked.” What does it mean? 
A. As a security precaution, you are temporarily locked out after too many failed sign-in attempts. These lockouts are 
cleared periodically. Try again the next day. 

Q. What if nothing works?  
A. As a security precaution, you are temporarily locked out after too many failed sign-in attempts. These lockouts are 
cleared periodically. If you think you are locked out, try again the next day.  

Q. I don't know my user ID or initial password. Who should I contact? 
A. Contact your Human Resources or Payroll office.  

Q. When trying to sign in, I receive the message "java.lang.NullPointerException" or “Bea.jolt…” 
What does it mean? 
A. These messages can mean more than one thing. Self Service could be down, or you may have entered the 
incorrect password. Ask a co-worker to sign in. If he or she receives the same message, try again later. If your co-
worker is able to sign in, check your password and try again.   

Q. How do I change my password? 
A.  

1. Go to www.state.mn.us/employee.  
2. Sign in to the Self Service website.  
3. Select State of MN Self Service to access the State of MN Self Service page. 
4. On the State of MN Self Service page, select My profile. The General Profile Information page displays.  
5. Click Change password. The Change password page displays.  
6. Enter your current password in the Current Password field.  
7. Tab to the New Password field and enter a password of your choosing. See Are there any requirements or 

guidelines for creating a password? 
8. Tab to the Confirm Password field and enter the new password again.  
9. Click OK. Unless you receive an error message, your password has been saved. 
10. The General Profile Information page displays.  

http://www.state.mn.us/employee
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Q. Are there any requirements or guidelines for creating a password? 
A.  

• Passwords: 
o Must be at least eight characters (the exception is your initial password which is 4 digits). 
o Must include at least one number. 
o Must include at least one of the following special characters ! @ # $ % ^ & * ( ) - _ = + \ | ] } [ 

{ ; : / ? . > < , ` 
o Are case-sensitive. 
o Cannot be reused for at least six password cycles. The system keeps track of your previous six 

passwords and prevents you from reusing them. 
o Expire after 60 days. 

 
• Additionally, we recommend the following characteristics for strong passwords:   

o It should not be your name, spouse’s name, child’s name, pet’s name, parent’s name, etc. 
o It should not be a dictionary word. 
o It should be significantly different from previously used passwords (not just incrementing a counter, 

for example). 
o It should contains characters from each of these four groups: 

• Upper case letters (A, B, C, …) 
• Lower case letters (a, b, c, …) 
• Numbers (1, 2, 3, …) 
• Special characters   ! @ # $ % ^ & * ( ) - _ = + \ | ] } [ { ; : / ? . > < , ` 

 
• Make sure you change your initial password. 
• You should change your password on a frequent basis. 
• Do not store passwords in readable form on your computer or in any location where unauthorized persons 

might discover them.  
• Do not share your password with anyone. If another person learns your password, change it immediately.  

Q. How will I know when my password is going to expire? 
A. The system will prompt you when it's time to change your password. 

Q. What if my password will be expiring soon? 
A. Self Service passwords expire after 60 days. Beginning 10 days before the password expires, you will see this 
message after you sign in: "Your password will expire in x days. Do you want to change your password now?" If you 
are ready to change your password, follow these steps: 

1. Click Yes.  
2. On the State of MN Self Service page, select My profile.  The General Profile Information page displays.  
3. Click Change password. The Change password page displays.  
4. Enter your current password in the Current Password field.  
5. Tab to the New Password field and enter a password of your choosing. See Are there any requirements or 

guidelines for creating a password? 
6. Tab to the Confirm Password field and enter the new password again.  
7. Click OK. Unless you receive an error message, your password has been saved. 
8. The General Profile Information page displays.  

Q. What if my password has expired? Can I still sign in? 
A. Yes, but what you need to do depends on the message you receive: 

• If you receive a message that your password is invalid, obtain a new password by selecting "Forgot Your 
Password?" Sign in with the new password and then change it. See Are there any requirements or guidelines 
for creating a password?  

• If you receive a message that your password has expired, you can still access Self Service as long as you 
change your password immediately by selecting "Click here to change your password." 

1. Enter your current password in the Current Password field.  
2. Tab to the New Password field and enter a password of your choosing. See Are there any 

requirements or guidelines for creating a password? 
3. Tab to the Confirm Password field and enter the new password again.  
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4. Click Change Password. If your password change is successful, this message will display: “Your 
password has successfully been changed.” 

5. Click OK. 

Q. I’ve had my password for three weeks. Today, I received an error message indicating that my password 
has expired. It hasn’t been more than 60 days; why did I receive this message? 
A. The password expiration date will reset if you change your password on the Change password page. However, if 
you receive a system-generated password via the "Forgot Your Password?" link, and do not change it, the password 
expiration date will not reset. This could result in receiving the “Your password has expired” message sooner than 
expected. 

Password Hint 

Q. How Do I Change the Forgotten Password Hint?  
A. You can control how the system will validate your identity. This provides enhanced security and flexibility for you. 
Complete the following steps anytime before you need to use the "Forgot Your Password?" link.  

1. Go to www.state.mn.us/employee and sign in.  
2. Select State of MN Self Service to access the State of MN Self Service page. 
3. On the State of MN Self Service page, select My profile.  The General Profile Information page displays.  
4. Select Change or set up forgotten password hint. The Change or set up forgotten password hint page 

displays.  
5. In the Question field, highlight the existing question and type a different question, up to 50 characters. 

Note: Enter a question for which you will always remember the answer and that only you can answer 
correctly. Avoid questions with answers that are easily guessed.  

6. In the Response field, highlight the existing answer and enter the correct answer to the question, up to 30 
characters. The answer is not case-sensitive.  

7. Click OK. Unless you receive an error message, your change has been saved. 
8. The General Profile Information page displays.  

Sign-in 

Q. Will I be locked out of the system after a certain number of attempts to sign in?  
A. Yes. After a number of unsuccessful attempts, it's possible that you have been locked out. Try again the next day. 

Q. If I am suspended from signing in, what do I do? 
A. The system clears suspensions periodically. Try again the next day.  

Q. What if the sign-in page says Database Maintenance is being performed and I can't sign in? 
A. Occasionally, you may see this message. The site is generally available 24 hours a day 7 days a week. However, 
there are times when database maintenance needs to occur. This is generally Sunday morning from 7:00 a.m. to 
noon. Usually the maintenance doesn't last very long. Try again later. 

Q. Why does the processing icon  keep flashing? 
A. The function of this message is to tell you the system is busy. If it continues too long, do the following: 

• On a work computer, contact your agency technical staff.  
• On a home computer, if you are using Microsoft Internet Explorer, select the following: Tools, Internet 

Options, Advanced tab and scroll down to Security. Ensure that the box next to "Do not save encrypted 
pages to disk" is NOT checked. Click OK and close the browser. Open the browser and try again.  

http://www.state.mn.us/employee
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Q. What if I can't sign in from home? 
A.  

• Make sure your computer meets the requirements; see Self Service Software and Hardware Requirements. 
If you don't have a supported browser, consider downloading one of the browsers listed.  

• You may be typing your User ID and password incorrectly. Double-check your User ID and password. Make 
sure you type upper or lower case correctly. Request a temporary password if necessary by clicking ""Forgot 
Your Password?" After you get in with the temporary password, change it. 

• You can also try clearing cookies and temporary internet files.  
• On your home computer, if you receive the message “url is required”, you may want to add *.state.mn.us 

to your browser’s trusted sites. If your browser requires server verification (https:) for all trusted sites, you 
would add https://*.state.mn.us to the trusted sites. 
To add *.state.mn.us or https://*.state.mn.us to your browser’s Trusted Sites, it would be best if you have a 
computer savvy friend or relative assist you. Please follow the steps below. (Note: These are the steps for 
doing this in Internet Explorer version 8.0.) Other browsers have similar functions that you can look up in the 
browser's Help.)  

Internet Explorer version 8: 
• Open Internet Explorer. 
• Select Tools > Internet Options > Security > Sites. 
• Enter the website in the text box, Add this website to the zone: and click the Add button. 
• Click the Close button, then the OK button to close the popup windows. 

Email Address 

The Email Address field on the General Profile Information page is for your work email address. If the email address 
is missing or incorrect, you can fix it by completing the following steps. 

1. Go to www.state.mn.us/employee and sign in. 
2. Select State of MN Self Service to access the State of MN Self Service page. 
3. On the State of MN Self Service page, select My profile. The General Profile Information page displays. 
4. In the Email Type field, select Business. (This is the only email type available.) 
5. If you are a State of Minnesota employee, enter your State of Minnesota work email address. For most 

employees, the format is: Firstname.Lastname@state.mn.us. Do not enter your home or private business 
email address when the email type is Business. If you are not a State of Minnesota employee, enter the email 
address where you wish to be contacted regarding business matters. 

6. If it’s not selected already, select the Primary Email Account check box next to the Business email type. Don’t 
clear it. 

7. Click the Save button. 

State of Minnesota executive branch employees’ work email addresses (Business email addresses) are considered 
public data. State of Minnesota employees’ work email addresses will be shared with other State of Minnesota 
computer systems. Note: Entering or changing an email address here does not update the state directory. 

Home Address 

Q. I’m having trouble changing my home address. I can’t find my city/county in the list. What should I do? 
A. Changing an address in the current version of the software is tricky. Please try again following the steps below. If it 
still doesn't work, please contact your agency’s HR office to have your home address updated. 

1. Go to www.state.mn.us/employee and sign in. 
2. Select State of MN Self Service to access the State of MN Self Service page. 
3. On the State of MN Self Service page, select My Personal Information, then Home and Mailing Address. The 

Home and Mailing Address page displays. 
4. Click the Edit button. 
5. After entering your street address, you need to identify the STATE.  
6. Then go to the CITY field and type just the first letter of that city as a CAPITAL letter. (A lower-case letter will 

not return any values.) Click on the magnifying glass to the right of that field. You will get a list of all of the 
cities in that state which begin with that letter. Select your city. This method prevents minor formatting issues 
which often are the cause of address change difficulties. 

http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
http://www.state.mn.us/employee
http://www.state.mn.us/employee
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7. Once you have the city (by using the magnifying glass), go to the COUNTY field and search using the 
magnifying glass to the right of that field.  The system should reply with one or more county options. Select 
your county.  

8. Enter the date the change will take effect or accept the default (today’s date). 
9. Click the Save button. 

If your county is not on the list of county options for that city (when searched in this manner), please contact your 
agency’s HR office to have your home address updated.  Occasionally the county boundaries or city boundaries 
change, and they may need to report this to Minnesota Management & Budget (MMB). 

Cookie and Internet File Problems 

Q. I am on a page, and it does not display and/or act normally. What should I do? 
A. You can try clearing cookies and temporary internet files. (These are the steps for doing this in Internet Explorer 
version 7.0 – version 9.0 and Mozilla Firefox. Other browsers have similar functions that you can look up in the 
browser's Help.) 
 

Instructions for Internet Explorer Version 7 - 9: 
Internet Explorer version 7:  

1. Close all browser windows. Open one Internet Explorer window. 
2. In your browser click “Tools” and then “Internet Options”.  
3. On the “General” page, click the “Delete…” button beneath the “Browsing history” section.  
4. At the bottom of the “Delete Browsing History” pop-up, click the “Delete all…” button. 
5. On the “Delete Browsing History” pop-up, click the “Also delete files and settings stored by add-ons” 

checkbox. 
6. Click the “Yes” button.  
7. On the “Internet Options” pop-up, click the “OK” button. 
8. Close your browser session (be sure all browsers are closed). 

- OR - 
Internet Explorer version 8 or 9: 

1. Close all browser windows. Open one Internet Explorer tab/window. 
2. In your browser click “Tools” and then “Delete Browsing History”.  
3. On the “Delete Browsing History” pop-up, select the top four checkboxes and click the “Delete” 

button. 
4. On the Delete Browsing History window, select the top four checkboxes and click the Delete button.  
5. After the browsing history has been deleted, close the browser. (Be sure all browsers are closed.) 

 

Next, do the following steps for Internet Explorer 7 - 9 only to delete “deep cache”:  
1. Open one Internet Explorer tab/window, select Tools > Internet Options. The Internet Options 

window opens. 
2. On the Internet Options window, under Browsing history, click the Settings button. The Temporary 

Internet Files and History Settings window opens. 
3. On the Temporary Internet Files and History Settings window, click the View files button. The 

Temporary Internet Files window opens. 
4. Any and all files displayed here should be deleted. Select all files in the window (pressing the Ctrl 

and A keys simultaneously works nicely), then press the Delete key. Click Yes to “Are you sure you 
want to delete the selected cookies?” 

5. Close the Temporary Internet Files window. 
6. Click the OK button on the Temporary Internet Files and History Settings window and on the Internet 

Options window. 
7. Close the browser. (Be sure all browsers are closed.) 
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Instructions for Mozilla Firefox: 
1. Close all browser windows. 
2. Open one Firefox window. 
3. Go to Tools > Clear Recent History,  
4. Check Browsing & Download History, Cookies, and Cache. Click OK. 
5. Close the browser window. 

 

Finally, restart your browser, go to www.state.mn.us/employee and try to sign in again. 

Q. A message says I have to "enable cookies." What are cookies and how do I enable them? 
A. Cookies are small text files stored on the hard disk when a user visits a website. Your browser's Help may provide 
information on cookies.  

• On a work computer, contact your agency technical staff.  
• On a home computer, consult your web browser's Help regarding enabling cookies.  If your computer has a 

virus package or some type of security software, you may also have to consult the software's Help regarding 
cookies.  

 
Q. I followed the cookie instructions above but still receive the "you must have cookies enabled" message. 
What else can I try? 
A. Check the clock settings on your computer. If they are incorrect, set them to the current date and time. To do this: 

1. Click Start in the bottom-left corner of your screen.  
2. Select Settings, Control Panel, and Date/Time. The Date/Time Properties box displays.  
3. If the date is incorrect, select the correct Month, Year and Date.  
4. If the time is incorrect, highlight it and type the correct time.  
5. Click OK.  
6. Try to sign in again. 

Display/Formatting Issues 

Q. I’m trying to access a page, but the page does not display. What should I do? 
A. If a page does not display, press the F5 key on your keyboard or click on the Refresh icon on your browser to 
refresh the page. 

Q. I am on a page, and it does not look normal. What should I do? 
A. You can try clearing cookies and temporary internet files.  

Q. The formatting of my paystub does not seem to be correct. What should I do? 
A. Make sure your computer meets the requirements; see Self Service Software and Hardware Requirements. If you 
don't have a supported browser, consider downloading one of the browsers listed.  

Q. Only a portion of my paystub displays on the screen. How do I view the rest of my paystub? 
A. You may need to use the horizontal and/or vertical scroll bars to view all of the information. You can also work with 
your technical staff to adjust your display settings. 

Q. On some pages, I need to use the horizontal scroll bar in order to view/enter my information. Is there an 
alternative to using the scroll bar? 
A. Work with your technical staff to adjust your display settings. 

Q. Why do some buttons and enterable fields contain text that appears to be cutoff? 
A. Certain display settings can affect viewing capabilities. Work with your technical staff to consider adjusting settings 
such as screen resolution, DPI and/or font size. 

Q. Why does the Ending Balance column on my Leave Activity By Pay Period page appear to be cutoff? 
A. Certain display settings can affect viewing capabilities. Work with your technical staff to consider adjusting settings 
such as screen resolution, DPI and/or font size. If you do not want to adjust your display settings, an alternative is to 
view your balances on the Leave Activity By Plan page. This page contains the same information; the only difference 
is that it sorts leave information by plan type instead of by pay period. 

http://www.state.mn.us/employee
http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
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Q. I try to access a document and it does not display. Why? 
A. In Self Service, many documents such as payroll forms and instructions are available as portable document format 
(PDF) files.  

To view or print PDF files in Self Service, you need to have the required version of Adobe Acrobat Reader; see Self 
Service Software and Hardware Requirements. The Adobe Acrobat Reader software is free and easy to install on 
your computer. The latest version is available on Adobe's website at http://get.adobe.com/reader/. If required by your 
agency, check with your technical staff before installing the software on your office computer. 

If you have the required version of Adobe Acrobat Reader and are still not able to view PDF files, it may be due to 
your web browser's pop-up blocker settings. If the PDF file pop-up window is blocked on your office computer, 
contact your technical staff for assistance. At home, consult your web browser's Help regarding pop-up windows. 

Leave Activity and Balances 

Q. Who should I contact if I find an error or have questions regarding my leave activity and/or balances?  
A. Contact your payroll or human resources office. 

Q. I want to view my leave activity from a prior year but it is not available. Why? 
A. At a certain point, payroll data is archived. Archived leave information is not available in Self Service. Contact your 
human resources or payroll office if you need historical information that has been archived. 

Paystub 

Q. Who should I contact if I find an error or have questions regarding my paystub? 
A. Contact your payroll or human resources office. 

Q. I selected the most recent “View Paycheck” button, and the paystub information is from a previous pay 
period. Why? 
A. You may be attempting to view paystub information before it is available. 

Q. I do not see year-to-date totals on my historical paystubs. Why? 
A. Year-to-date totals display on the latest paystub and the last paystub of the calendar year. 

Q. I want to view a paystub from a prior year but it is not available. Why? 
A. At a certain point, payroll data is archived. Archived paystubs are not available in Self Service. Contact your 
human resources or payroll office if you need historical information that has been archived. 

Q. My business expense reimbursements don’t appear on my paystub. Why? 
A. Business expense reimbursements for some employees will appear on a separate check and the employee will 
have two paystubs. The employee can click the “View a Different Paycheck” button to display the Employee 
Paycheck History page, which lists your available paychecks. 

Q. I no longer work for the state. How do I access my paystubs? 
A. Your paystubs will continue to be available on the Self Service website until they are archived. Your user ID is 
your employee ID (eight digits, all numeric). If you do not remember your employee ID, contact the human resources 
or payroll office of the last agency you worked for. If you do not remember your password or if it does not work, follow 
the instructions for What if I remember my password but it doesn’t work and receive the message “Your User ID 
and/or Password are invalid.”? 

http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
http://get.adobe.com/reader/
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Printing 

Q. My paystub or W-2 will not print. What should I do? 
A. Make sure you have selected the correct printer. Make sure the printer is turned on. Check to see if the printer is 
out of paper or jammed. 

Q. What is the most efficient way to print my paystub or W-2? 
A. For most people, clicking Print  in the upper right-hand corner of the page will produce a print of the paystub 
or W-2 on a single page. 

Q. When I print my paystub, part of it is cut-off. How do I get the entire paystub to print? 
A. Try adjusting the margins on all sides to .25” or less (margins are usually adjusted in page setup). Make sure your 
computer meets the requirements; see Self Service Software and Hardware Requirements. If you don't have a 
supported browser, consider downloading one of the browsers listed.  

Q. I am able to view my paystub or W-2 but when I print it, the page is mostly blank. What should I do? 
A. It’s possible that your browser version does not support printing without sacrificing security. Make sure your 
computer meets the requirements; see Self Service Software and Hardware Requirements. If you don't have a 
supported browser, consider downloading one of the browsers listed.  

Here are some other options: 
• Check to see if your agency has kiosks where employees can print paystubs. 
• Use Print Screen. 
• Copy and paste paystub/W-2 into a word processing application or text editor, format if necessary, and print. 
• Try the suggestions for How can I get it to print larger? 

Q. When I print my paystub or W-2, the text is too small. How can I get it to print larger? 
A. Make sure your computer meets the requirements; see Self Service Software and Hardware Requirements. If you 
don't have a supported browser, consider downloading one of the browsers listed. Use the Print link between Home 
and Sign out in the upper right corner of the Self Service screen, instead of using the Print option on your browser. If 
the paystub is too small or only the header prints out, here are some options: 
 

Internet Explorer Option #1: 
1. Click the Print link in the upper right corner of the Self Service screen. 
2. When the Print box appears, click the “Preferences” button. 
3. When the Printing Preferences box appears, click the “Effects” tab. 
4. Click the “% of actual size” radio button and use the scroll bar to move right. (Example: Use 125 in the box; 

This works with both Internet Explorer 7 and Internet Explorer 8.) 
5. Click OK. 

 

Internet Explorer Option #2: 
1. Right mouse click on the page and select “Select All” from the pop-up menu. All fields on the page are now 

highlighted. 
2. From the browser menu, select “File” and then “Print Preview.” 
3. Select “As selected on Screen.” 
4. Change the “Shrink To Fit” field to a percentage. (A suggested value is 95%; this works with both Internet 

Explorer 7 and Internet Explorer 8.) 
5. Click the Print icon. 

 

Mozilla Firefox Option #1: 
1. Right mouse click on the page and select “This Frame.” 
2. Select “Print Frame.” 
3. Select printer and click OK. 

 

Mozilla Firefox Option #2: 
1. On the page, highlight the area you want printed. 
2. Click on the Print link in the upper right corner of the Self Service screen. 
3. Under “Print Range,” select “Selection.” 
4. Click OK. 

http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf
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Safari Option #1: 
1. On the page, highlight the area you want printed. 
2. Click on the Print link in the upper right corner of the Self Service screen. 
3. Under “Print Range,” select “Selection.” 
4. Click OK. 

 

If these options do not suit your needs, you may need to work with your technical staff to find a solution that works for 
you based on the internet browser, internet version, operating system, individual settings and printer settings you are 
using. 

Q. When I print my paystub or W-2, only the header prints out. How can I get my paystub or W-2 to print? 
A. Make sure your computer meets the requirements; see Self Service Software and Hardware Requirements. If you 
don't have a supported browser, consider downloading one of the browsers listed.  If only the header prints out, try 
the suggestions for How can I get it to print larger? 

If those options do not work, try sending your paystub to a different printer, if possible.  Different printers may print 
differently and/or offer different options.  If none of these options suit your needs, you may need to work with your 
technical staff to find a solution that works for you based on the internet browser, internet version, operating system, 
individual settings and printer settings you are using. 

W-2 

Q. I no longer work for the state. How do I access my W-2? 
A. Your W-2 will be available on the Self Service website if you consented to receive your W-2 form electronically. 
(Note: Retirees who received an additional employee ID to access insurance information upon retirement must use 
their original employee ID to access their W-2.)  

Q. I have questions about the information on my W-2. Where can I go for help? 
A. For assistance in answering your W-2 questions, refer to the “W-2 Information” document available in Self Service. 
Select Other Payroll, W-2 Information and then W-2 Information (below the View W-2 Forms link). If you have 
questions after reviewing the document, contact your payroll office. 

Benefits 

Q. How do I enroll as a new employee or change my benefits? 
A. Contact your agency’s human resources/benefits office. 

Signing Out 

Q. How do I exit after I finish using the Self Service website? 
A. Click Sign out  in the upper right-hand corner of the page. If you do not sign out and you are using a public 
computer, the next person may be able to click the back button on the browser and view your information. It is 
important to also close all PDF files that opened in separate windows. If you don’t close the PDF files, they 
remain open and available to the next person using the same computer. 

Close the browser window only after you sign out. When the browser window is closed without signing out, the self 
service session continues to be connected for several more minutes before it is terminated. These unnecessary 
connections reduce available resources for other users. 

Q. When I click Sign out  to exit Self Service, will PDF files automatically close? 
A. No. You must close all PDF files that opened in separate windows. If you don’t close the PDF files, they remain 
open and available to the next person using the same computer. 

http://www.mmb.state.mn.us/doc/sema4/ss/software.pdf


9/12         11 

Other Questions 

Q. How safe is my information? 
A. Your data is secure in more than one way: 

• Firewalls restrict access to the servers. 
• Secure Socket Layer technology uses 128 bit encryption. 
• Security of the servers is certified by VeriSign. 
• Your user ID and password create a key so that only you can access your data. 

Q. Why do I receive the "Page has expired" message when I click the back or forward arrows on the browser 
toolbar? 
A. The page you expected to see has been deleted from your computer’s files. This is a security feature. If you 
receive this message, click the Refresh or Reload button located on your Internet browser toolbar or click Home to 
return to the Self Service page. 

Q. Why do I receive the “Data is Missing” message? 
A. The page you expected to see has been deleted from your computer’s files. This is a security feature. If you 
receive this message, click the Refresh or Reload button located on your Internet browser toolbar or click Home to 
return to the Self Service page. 

Q. Why does the Web page expire after 10 minutes? 
A. After 10 minutes of inactivity, the system signs out automatically. This is a security feature. To keep the system 
active, click a button, link, or icon on the Web page. Once the page expires, you may sign in again or close the page. 

Q. I can sign into Self Service, but the links to paystub and other payroll information are not active. 
A. If you are separated from state service (such as if you are retired) and you were assigned a benefits ID to access 
insurance information in Self Service, you may have signed in with the benefits ID. The benefits ID cannot access 
payroll information. To access payroll information such as your W-2 forms or paystubs, you must sign in with your 
original state employee ID. If you don't know what your original employee ID is, contact the human resources or 
payroll office of the last agency you worked for. 

Q: When I use Forgot Your Password and click OK on the popup showing the system-generated password, 
I’m supposed to return to the Self Service Sign in page. Instead, my web browser closes. 
A. Open your browser and go to www.state.mn.us/employee again. Enter your User ID (all eight digits, including any 
leading zeros) and the system-generated temporary password to sign in. 
If you are unable to sign in, you can try clearing cookies and temporary internet files.  

Q. What should I do if I have one of these problems in Self Service: 
• I receive a message referring to an Object Error. 
• I’m in Forgot Your Password. When I enter my user ID or enter the answer to my validation question, 

I’m returned to the Self Service Sign In page. I can’t get any further with Forgot Your Password, and 
there is no error message. 

A. You can try clearing cookies and temporary internet files.  

Q. Who should I contact if I find an error or have questions regarding my human resources, benefits or 
payroll data? 
A. Contact your human resources, benefits or payroll office. 

If you have tried all of the tips above and are still having problems, the agency's technical staff may contact 
selfservice.mmb@state.mn.us for assistance with technical problems on the Self Service website. We will respond to 
email inquiries as soon as possible. However, this email box is not monitored on weekends, holidays or evenings. 

http://www.state.mn.us/employee
mailto:selfservice.mmb@state.mn.us
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